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Введение в ТitleMotion

Inscriber © TitleMotion™ - это профессиональный графический плагин для
создания высококачественных титров для видео, и быстрого создания эффектов их
движения. TitleMotion (далее ТМ) предлагает обширный контроль над всеми проектами,
выходными аспектами и всей графикой ТМ, включая полную поддержку каналов кеинга.

Эффекты движения титров в ТМ, позволяют создавать мультислойные анимации
для полета любых объектов вокруг экрана, используя настраиваемые траектории
движения. Все объекты могут быть перевернутыми относительно геометрических осей,
скрученными, вращающимися или двигающихся индивидуально в виртуальном 3D
пространстве, при этом каждый объект может иметь независимые ускорения и
замедления. Вы можете также применять фильтры для анимации объектов во
времени.

Время рендеринга для эффектов движения очень мало. Анимации
устанавливаются в режиме кейфреймов. Вы можете видеть превью в реальном
времени, используя Вашу систему нелинейного монтажа (далее NLE).

Использование ТМ состоит из 4 основных шагов:
1. Открытие ТМ из Вашей NLE.
2. Создание титра.
3. Добавление эффектов движения титра.
4. Возвращение в Вашу NLE для просчета титров или

анимации.

                                          Откройте ТМ из
                                      Вашей NLE                             Ваша
                                                                                        NLE

                                Создайте титр

                                     Добавьте эффекты
                                     движения

                                      Вернитесь в Вашу
                                      NLE для                                  Ваша
                                      использования                      NLE
                                      титров и Анимаций
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Изучение ТМ

Модули ТМ

TM состоит из 3 модулей: генератора титров (CG), модуля создания Лого (Logo
Compose)  и модуля создания эффектов движения титров (FX)

• СG позволяет Вам создавать неподвижные титры (Still), двигающиеся
вертикально титры – барабан (Roll), двигающиеся горизонтально титры (Crawl),
основанных на шаблонах (Templates) по умолчанию или полностью готовых
шаблонах. Вы также используете СG для создания начальных титров для
Анимации.

• Logo Compose позволяет Вам очистить или добавить альфа-канал к любому
изображению и затем использовать его как изображние СG.

• FX позволяет добавить Анимацию к любому титру, созданному в CG.
• Scrapbook (далее Sb) это блок ТМ, позволяющий Вам обмен изображениями,

титрами и стилями между титрами и между модулями ТМ.

Об этом описании

Это описание разработано для того, чтобы дать Вам начальные знания обо всех
основных особенностях, доступных в ТМ. Изучив его, Вы сможете решать все основные
задачи. После этого, Вы можете перейти к изучению онлайновой справки (по нажатию
клавши F1) для более детального изучения специфических  возможностей.

Онлайновая справка

Система онлайновой справки разработана таким образом, чтобы дать Вам всю
необходимую информацию обо всех применяемых функциях , доступных в ТМ.
Открыть ее можно, выбрав Help -> Help Topic из строки меню. В ней, так же,
содержится полный словарь терминов.

Экран ТМ
                                                                                                                                  Панель                    

         Основная                                                                                               модулей
           панель
      инструментов
                                                                                                                          Инструменты
    Окно Editor-а                                                                                               или палитра
(монтажное окно)                                                                                      Форматирования

                                                                                                                                        Образец
                                                                                                                     Форматирования
                                                                                                                      (только в CG)

           Закладки
          Атрибутов                                                                                         Scrapbook
                                                                                                                     (промежуточ-
                                                                                                                      ное хранилище)
Панель Статуса
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Знаете ли Вы….

Эта глава объясняет некоторые основные особенности ТМ, которые ускоряют
работу в ней. ТМ обеспечивает дополнительными возможностями ввода чисел в
числовые поля, переключения между основными свойствами, а также предоставляет
полезные инструменты для работы.

Быстрое изменение числовых значений.

ТМ предоставляет различные пути введение числовых значений в числовые поля:

1. Вы можете непосредственно ввести число с клавиатуры.
2. Вы можете нажать на стрелки вверх или вниз справа от числового поля для

увеличения или уменьшения числа.
3. Вы можете использовать опцию Inscriber Scroll. Нажмите левой клавишей мыши

над числовым полем, и переместите указатель вверх или вниз для увеличения
или уменьшения значения соответственно. Это наиболее быстрый метод
изменения значения.

4. Вы можете вернуть числовое значение по умолчанию двойным щелчком на
числовом поле.

                                                     Введите числовое значачение с клавиатуры  

                                                      Нажмите на стрелки вверх или вниз для увеличения
                                                и уменьшения значения, соответственно

                                               Нажмите левой клавишей мышки в числовом поле и
                                               перетащите ее вверх или вниз

                                                Двойной клик на числовом поле возвращает значение
                                                по умолчанию
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Изменение слоев в CG.

Каждый титр в CG имеет 10 слоев, и каждый из них делится на плоскость текста
и плоскость графики. Вы можете увидеть что текст и графика располагаются на своем
слое, выбрав из строки меню Element -> Layer Control -> Layer List (Элемент –
Управление Слоями – Список Слоев), после чего, появится диалоговое окно Layer List.

Текст каждого слоя всегда находится над графикой. Если Вы хотите расположить
графику над текстом, Вам необходимо поднять ее на слой выше чем слой с текстом.
Вы можете передвигать текст и графику между слоями CG, используя мышь и
клавиатуру.

1. Нажмите одновременно Ctrl и Shift на клавиатуре.
2. Кликните на объект, который Вы хотите переместить на другой слой и

переместите указатель вверх или вниз.

Число возле указателя показывает номер слоя. Двигая указатель вверх, номер слоя
увеличивается и Вы переходите на болем верхний слой. Двигая указатель вниз, номер
слоя уменьшается соответственно.

3. Отпустите левую клавишу мыши когда счетчик показывает номер слоя, на
который Вы хотите переместить текст или графику.

         Нажмите на объект и перетащите
                                         указатель вверх или вниз

         Нажмите и удерживайте
        одновременно клавши
        CTRL и SHIFT

Отпустите кнопку мышки,
когда справа появится
нужный номер слоя

Вы, так же, можете изменить слой строки текста или подложки, нажав клавши Ctrl
и Shift и нажимая стрелки вверх или вниз на Вашей клавиатуре. Увидеть номер слоя
Вы можете, посмотрев на строку статуса, внизу окна ТМ.
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Кнопки зацикливания закладок

ТМ использует кнопки зацикливания закладок, которые дают больше доступа к
настройкам на закладке Attributes (Атрибуты). Они обозначены большим
треугольником вверху.

Левый клик на кнопке зацикливания двигает Вас к другим функциональным
настройкам. Правый клик на кнопке зацикливания, двигает Вас назад через набор
функций циклической кнопки. Следующий рисунок показывает Вам доступные функции
циклических кнопок на закладке Color & Textures (Цвет и Текстуры).

1. Левый или правый клик на циклической кнопке переводит к другим функциям.

Вы можете нажимать на кнопку больше одного раза, и тогда Вы вернетесь к
первоначальной функции.

Нажимайте на кнопку
зацикливания для передвижения
по различным настройкам

Окна заготовок выбора цвета

Окна заготовок выбора цвета Face (Лицевой стороны букв), Edge (Окантовки) и
Shadow (Тени) предназначены для более быстрого доступа к особым циклическим
кнопкам, чем, нажимая на циклическую кнопку для перебора всех функций.

Окно выбора цвета Face
(Лицевой стороны символа )

Окно выбора цвета Edge
(Окантовки символа)

Окно выбора цвета Shadow
(Тени символа)
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Введение специальных символов

Каждый шрифт состоит из бОльшего  количества символов, чем мы видим на
клавиатуре. Одними из таких символов являются символы копирайта и торговой марки
(©, ™), символы дробей (⅓ и т. д.), и символов с ударениями (Ẻ,ẻ).

Использование мыши

1. Убедитесь, что выбран режим текста на текущем слое CG.
2. Выберите шрифт из списка шрифтов в ниспадающем меню на закладке Size &

Attributes.
3. Выберите Edit -> Character Map (Правка-Карта Символов)
4. Нажмите на символ, который Вы хотите добавить на строке текста.
5. Используйте клавишу Backspace для очистки любого неправильно выбранного

символа.
6. Когда Вы окончательно выберите символ для вставки , нажмите на ОК и

вернитесь к титру в CG.
Если Вы не хотите использовать выбранный символ в Characrer Map, нажмите на
кнопку Cancel для возврата к титру в СG без введения любого нового символа.

                                                                                            Убедитесь, что выбран режим
                                                                                    текста в текущем слое CG

     Выберите шрифт

                                                          Выберите Edit -> Character Map

Нажмите на символе,
который хотите
выбрать для
добавления к титру

        Нажмите кнопку Backspace                               Нажмите на кнопку ОК для
        для удаления символа                                      подтверждения выбора символа
                                                                                        или на кнопку Cancel для отмены
                                                                                        любых изменений
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Использование клавиатуры

Если Вы не хотите всегда держать открытой Caracter Map для введения
специальных символов, то используйте кейкоды с помощью клавиатуры.

1. В Caracter Map расположите указатель мыши над символом, который Вы
хотите вставить.

2. Запишите или запомните число в всплывшем окошке ToolTip (окне-подсказке).
3. Закройте Caracter Map.
4. Нажмите клавишу Alt и, удерживая ее, введите на клавиатуре запомненное

число из Caracter Map.

Использования меню правого клика мыши

Меню по правому клику мыши обеспечивает самый быстрый доступ к некотором
основным функциям и командам. Оно упоминается в следующих понятиях:

• Рабочее пространство CG
• Окно заготовки CG Style
• Рабочее пространство FX
• Закладки Attributes FX
• Палитра инструментов FX (FX Tool palette)
• Рабочее пространство Logo Compose
• Scrapbook

1. Правый клик на одной из этих областей показывает меню по правому клику
2. Используйте мышь для выбора одной из команд в появившемся меню. Вы

можете закрыть меню правого клика, нажав в любом месте рабочего
пространства.

                                                                          Щелкните правой кнопкой мышки для
                                                                          просмотра меню по правому клику

                                                                          Используйте мышку для выбора пунктов
                                                                          из меню по правому клику
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Основы ТМ

Работа с NLE’s

ТМ работает как плагин к Вашей системе нелинейного монтажа. И поскольку с
каждой NLE она работает немного по-разному, Inscriber создал серию релизов
примечаний, описывающих работу ТМ с каждой NLE индивидуально. Эти примечания
доступны на веб-сайте www.inscriber.com

В основном, Вы открываете ТМ из Вашей NLE, создаете и запоминаете Ваш
титр, закрываете ТМ и возвращаетесь в NLE, где Вы можете открыть Ваши титры из
папок NLE или библиотек.

Создание титров

Эта глава объясняет самый быстрый путь создания титров в ТМ.

1. Выберите Template (Шаблон) 1123 Lower Third 23 из открывающегося списка
2. Двойным щелчком на слове Heading (Заголовок) выберите его.
3. Введите новый текст в строке.

    Выберите шаблон

   Сделайте двойной
   клик на слове Heading

   Введите новый текст

http://www.inscriber.com
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Сохранение титров

Вы можете сохранить Ваш титр, выбрав File -> Save.

Когда Вы запоминаете файл в ТМ, он попадает в папку, библиотеку или в
противном случае, располагается там, где Ваша NLE ожидает найти файлы CG и
Анимации.

Если ТМ установлена не как плагин к NLE, а работает в режиме Stand-alone
(самостоятельно), Вы можете использовать команду File -> Export для экспорта титров
и Анимаций как последовательность тарг (*.tga), которые может импортировать Ваша
NLE. В онлайновой справке объясняется более детально, как экспортировать титры.

Открытие титров

Вы можете открыть титр, выбрав File -> Open.

Когда Вы откроете титр, ТМ покажет стандартное окно диалога Windows, которое
позволяет передвигаться по нему и выбрать Ваш файл с расширением *.ins.

Если Вы хотите открыть не .ins файл, то необходимо использовать команду File –
Import, для открытия файлов с расширениями .cgr, .icg, .sly, или .txt.
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Scrapbook (Промежуточное хранилище)

Scrapbook (далее Sb) используется для передачи титров, фонов, лого, текстур и
стилей как между титрами, так и между модулями в ТМ. Каждый модуль использует Sb
по-разному. Любые пункты, занесенные в Sb, всегда запоминаются, когда закрывается
ТМ, и при новом открытии, они остаются доступными для использования.

Когда Вы впервые открываете ТМ, Sb пуста, и над словом Scrapbook изображен
логотип Insciber. Пункт, видимый в Sb, есть выбранным пунктом. Когда Вы добавляете
пункт в Sb, он появляется в ней и становится выбранным. Вы можете использовать
полосу прокрутки под Sb для выбора различных пунктов. Она появляется только тогда,
когда в ней находится несколько типов в Sb.

Меню по правому клику в Sb меняется в зависимости от того, в каком модуле Вы
сейчас находитесь. В Logo Compose пункт Use всегда одинаковый, но в CG он
меняется в зависимости от типа выбранного пункта в Sb. Если тип пункта может быть
использован для одного параметра, то буден доступен только один пункт Use. Но если
Вы используете различные параметры, то вместо него будет появляться список
возможных пунктов Use.

Варианты  меню по правому клику в Sb:

                    Стандарное меню

                                                                                  Дополнительный модуль меню в СG
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Расшифровка пунктов меню по правому клику

В этой таблице расписаны пункты меню по правому клику в Sb.

Menu Option                                           Result
Add • Копирование пункта в Sb
Use • Применяет выбранный в Sb пункт

• Появляется, если пункт имеет только одну возможную
опцию Use

Use Background • В CG, копирует выбранный пункт в слой фона титра, и
замещает там существующий.

Use Texture • В CG копирует выбранный пункт в карту текстур (Texture
Map)

Use Layout/Title • В CG, замещает текущий титр выбранным пунктом в Sb
Use Logo • В CG, копирует выбранный пункт в карту Лого (Logo Map)
Delete • Удаляет выбранный пункт из Sb
Clear All • Удаляет все пункты из Sb
Copy to Clipboard • Копирует, выбранный пункт Sb, в клипборд Windows
Paste from
Clipboard

• Добавляет пункт из клипборда Windows в Sb

Info • Открывет диалоговое окно, которое позволяет узнать
сколько пунктов в Sb и сколько дискового пространства
использует Sb
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Sb и CG

Добавление пункта в Sb

Вы можете добавлять заготовки стилей и титров в Sb, используя меню по
правому клику. Вы также можете перетащить заготовку стиля в Sb.

1. Создайте титр или выберите один из шаблонов в CG.
2. Сделайте правый клик на Sb.
3. Выберите Add из появившегося меню для добавления титра в Sb.
4. Перейдите в закладку Styles, нажав на нее.

  
                                                                              Создайте или откройте титр в CG

                                                                                     Сделайте правый клик на Sb

                                                                                      Выберите Add из меню по
                                                                                      правому клику

                                                                                         Нажмите на закладку Style

5. Нажмите на окне заготовки стиля.
6. Сделайте правый клик на окне Sb и выберите пункт Add.
7. Выберите другую заготовку Style и перетащите ее в Sb.
8. Используйте полосу прокрутки (Scroll bar) для просмотра пунктов в Sb.

       Нажмите на окне      Выберите Add из меню
       заготовки стиля        по правому клику

Перетащите заготовку стиля в Sb

                                                                                      Используйте полосу прокрутки
                                                                                      Для просмотра пунктов в Sb
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Использование пунктов в Sb.

1. Используя полосу прокрутки, выберите пункт в Sb.
2. Сделайте правый клик на Sb и выберите одну из функций Use из меню.

                             Используя полосу прокрутки,             Выберите одну из  опций Use
                        выберите пункт                                      из меню по правому клику

Удаление пунктов из Sb.

Вы можете удалить одиночный пункт или все пункты из Sb.

1. Правый клик на Sb.
2. Выберите Delete, для удаления ранее выбранного пункта в Sb.
3. Выберите Clear All для удаления всех пунктов из Sb
4. Нажмите Yes для подтверждения удаления всех пунктов из Sb.

!   Вы не можете восстановить  удаленные пункты из Sb.

Сделайте правый клик
на Sb

Выберите Delete для
Удаления пункта

Выберите Clear All для
Удаления всех пунктов

                                                                                                               Нажмите Yes для
                                                                                                               подтверждения
                                                                                                                удаления всех
                                                                                                                пунктов
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Sb и другие модули ТМ.

Sb и Clipboard.

Вы можете копировать образы (изображения) из Sb в Windows Clipboard и
обратно. Эта возможность позволяет Вам копировать образы из пакетов третьих
производителей в Clipboard, и затем импортировать их в Sb, для использования в
любом модуле ТМ.

1. Скопируйте образ в Clipboard из пакета третьего производителя (выделите его и
нажмите Ctrl+C)

2. Откройте ТМ.
3. Правый клик на Sb и выберите Paste from Clipboard (Вставить из Клипборда ).
4. Войдите в модуль ТМ, в котором хотите использовать образ.
5. Выберите один из пунктов Use… из меню правого клика в Sb.

                                            Скопируйте изображение в Клипборд

                                       Откройте ТМ

        Выберите                 Перейдите в модуль,         Выберите одну  из  опций Use
        Paste From                в котором хотите
        Сlipboard                   использовать образ

Вы можете, так же перетащить и вставить в Sb любой файл с расширением .bmp
из десктопа или любой программы Windows, используя технику drag-and-drop.
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Sb и Logo Compose.

В Logo Compose Вы можете добавить изображения в Sb, добавить пункты Sb к
изображению в Logo Compose. Любое изображение Logo Compose в Sb будет фоном.

Добавление изображения из Logo Compose в Sb.

1. В Logo Compose открываем одно из изображений в папке Samples,
расположенной в директории ТМ.

2. Правый клик на Sb.
3. Выбираем Add из меню по правому клику.

                                                                                     Открываете или создаете
                                                                           изображение в Logo Compose

                                                                                       Делаете правый клик на Sb

                                                                                      Выбираете Add

Добавление пунктов Sb к изображению Logo Compose.

1. Используйте полосу прокрутки для выбора титра или фона в Sb. Вы не можете
использовать заготовки стилей в Logo Compose.

2. Выберите Use из меню по правому клику.

Когда Вы добавляете пункт Sb к изображению в Logo Compose, размеры
изображения не меняются. Вы можете увеличить размеры границ, если пункт
слишком большой, или обрезать их, если пункт очень маленький.

                                                                                                                 Выберите Use из
                                                                                                                 меню по правому
                                                                                                                 клику

Используйте полосу
прокрутки для выбора
титра или фона

Sb  и FX .

Sb в не работает в FX. !!!
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Менеджер шаблонов (Templates Manager).

Менеджер шаблонов хранит и упорядочивает заготовки титров. ТМ поставляется
с более 150 шаблонами от Inscriber, но Вы так же можете использовать Менеджер
шаблонов для добавления и организации своих собственных заготовок.

Что такое шаблон (Templates)?

Шаблоны определеляют титры в CG. Все титры базируются на шаблонах. Если
Вы не используете шаблоны из Менеджера, то Ваши титры будут основаны на
шаблоне по умолчанию. Шаблон по умолчанию – это начальные установки Ваших
титров. Стили текста, графические стили и Лого включены в шаблоны так, чтобы титры,
основанные на том же самом шаблоне, могут использовать те же самые Лого и стили.
Некоторые представленные в Менеджере стили очень просты, другие более сложные.
Вы можете сами проверить это, посмотрев их.

1. Нажмите на открывающийся список шаблонов.
2. Выберите шаблон 1130 Template Third из списка.

Когда вы передвигаете указателем над названием шаблонов, справа от списка
появляется окно с изображением шаблона. Это облегчает их поиск для титров.

                                                                                            Нажмите на открывающийся
                                                                                            список

                                                                                            Выберите шаблон
                                                                                            1130 Lower Third

Зачем использовать Менеджер шаблонов?

Менеджер шаблонов делает доступными заготовки из открывающегося  списка
шаблонов, который находится на панели инструментов ТМ.
Вы можете видеть изображение каждого шаблона, перемещая полосу прокрутки вниз.
Менеджер предоставляет быстрый и легкий путь к организации и поиску титров в ТМ.

Открывание и закрывание окна Менеджера шаблонов.

Вы можете открыть Менеджер шаблонов тремя способами:
• Выбрать File -> Templates Manager…
• Выбрать пункт Open Template Manager из меню по правому клику в CG.
• Нажать комбинацию клавиш Сtrl+Shift+R

Шесть кнопок в диалоговом окне обеспечивают Вас всеми необходимыми
инструментами для управления Вашими шаблонами.
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                                                                                 Инструменты для управления
                                                                         Вашими шаблонами

Вы можете закрыть Менеджер шаблонов двумя способами:
• Нажать кнопку Close.
• Нажать кнопку Esc.

Загрузка шаблона.

Вы можете загрузить шаблон, как текущий титр CG.

1. Откройте Менеджер шаблонов.
2. Выберите шаблон для загрузки.
3. Нажмите на кнопку Loаd Template (Загрузить шаблон) или дважды щелкните на

названии шаблона.

Менеджер шаблонов загрузит его в CG, делая текущим, после чего сам закроется.

                                  Откройте Менеджер           Выберите           Нажмите на
                                   шаблонов                            шаблон               Load Templates

Добавление шаблона.

Вы можете добавить текущий титр СG в Менеджер шаблонов как заготовку.

1. Создайте титр в CG.
2. Откройте Менеджер шаблонов.
3. Нажмите на кнопку Add.
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           Создайте             Откройте Менеджер       Нажмите на кнопку Add
                      титр в CG             шаблонов                                                

4. Введите номер шаблона.
Шаблоны сортируются по номерам. Все шаблоны от Inscriber имеют номера

выше чем 1000 и группируются согласно типам. Вы можете сделать такую же
сортировку по группам номеров для своих собственных заготовок.
5. Введите название шаблона.
6. Нажмите на ОК и Менеджер шаблонов закроется.

                                                Введите название для                     Нажмите на
Введите номер                     шаблона                                              кнопку ОК
для шаблона

Замена существующего шаблона.
Вы можете, изменить выбранный шаблон на текущий титр CG.

1. Откройте существующий шаблон в CG, и сделайте изменения.
2. Откройте Менеджер шаблонов.
3. Выберите шаблон для апдейта.
4. Нажмите на кнопку Update.
5. Нажмите на Yes, для замещения выбранного шаблона на титр CG, после чего,

Менеджер шаблонов закроется.

          Откройте и измените        Откройте Менеджер шаблонов
          шаблон

                                                                                                         Выберите шаблон

                                                                                                          Нажмите кнопку Update

                                                                                                          Нажмите кнопку Yes
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Переименование шаблона.

Вы можете переименовать шаблон и дать ему новый номер.

1. Откройте Менеджер шаблонов.
2. Выберите шаблон для переименования.
3. Нажмите на кнопку Rename (Переименовать).
4. Введите новые название и номер шаблона.
5. Нажмите  ОК и Менеджер шаблонов закроется.

Удаление шаблона.

1. Откройте менеджер шаблонов.
2. Выберите шаблон для удаления.
3. Нажмите кнопку Delete (Удалить).
4. Нажмите Yes для подтверждения удаления шаблона.

                                                                            Выберите шаблон              Нажмите на
                                                                                                                           кнопку Delete
Откройте
Менеджер
Шаблонов

Нажмите на
кнопку Yes
для удаления
шаблона

Шаблон по умолчанию.

Шаблон по умолчанию всегда нумеруется нулевым шаблоном и всегда
называется „Default Template”. Вы можете изменить содержимое шаблона по
умолчанию, заменив на текущий титр CG, но не можете его переименовать или
удалить.

Шаблон по умолчанию используется всегда, когда открываете ТМ или создаете
новый титр. Все титры основываются на шаблонах, и обычно, шаблон по умолчанию
самый простой - пустой шаблон. Однако, если Вам необходимо использовать текст или
графический элемент в каждом титре, Вы можете добавить его к шаблону по
умолчанию, создав титр с необходимыми элементами, и заменив им шаблон по
умолчанию.
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Стили.

Что такое стиль?

Стилями называются установки атрибутов для текста в CG, такие как высота,
цвет, размер бордюра и установки теней. Текст основан на стилях. Если Вы не
выбрали стиль, то Ваш текст форматируется шаблоном по умолчанию для титров.

Когда Вы к строке текста применяете стиль, он присваивается ей. Если Вы
делаете изменения атрибутов строки текста, то они касаются всех строк,
отформатированных этим стилем.

Все стили идентифицируются по номерам. Вы можете видеть все 24 стиля на
закладке Styles (Стили). Номер каждого стиля располагается в правом нижнем углу его
окна. Первых 8 стилей, так же, видны в Formatting palette (Палитра Форматирования).

Некоторые стили текста очень просты, другие более сложны. Вы их можете
посмотреть, когда откроете Style Library (Библиотеку стилей).

Стили текста запоминают информацию о размерах, атрибутах и цвете, но они не
запоминают информацию о текстурах. Если Вы хотите  использовать текстуры, то Вам
необходимо добавить их после того, как Вы примените стиль к тексту.

Что такое окно заготовки Стиля?

24 стиля, доступные в каждом шаблоне, сортированы в окнах заготовок стилей и
находятся на закладке Styles.  Каждая заготовка состоит из уникального стиля и может
быть применена  к строке текста в титрах СG. Вы можете применить другой стиль,
кликнув на заготовке стиля.

Когда Вы расположите курсор мыши над названием стиля, то появится
подсказка, в которой указано число и название шрифта, используемого в этом стиле.
Число определяет высоту символов шрифта, выраженную в сканлиниях. Оно дает
представление о высоте текста.

                                                                             Окно заготовки
                                                                             Стиля

                                         Закладка Styles
                                               (Cтили)

       Всплывающая подсказка
 (высота шрифта и его название)
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Меню по правому клику окна заготовки стиля.

Вы можете щелкнуть правым кликом на окне заготовки стиля, в таблице стилей
или на палитре форматирования, для доступа к всплывающему меню.

Пункты меню по правому клику Библиотеки стилей (Style Library), объясняются в
нескольких следующих главах. Другие пункты меню объясняются в онлайновой
справке.

Меню по правому
клику заготовки
стиля

Применение стиля.

1. Выделите некоторый текст, нажав на строке текста, или выделением нескольких
символов в пределах строки.

2. Перейдите на закладку Styles.
3. Нажмите на окне заготовки стиля.

       Выберите
       некоторый текст

      Перейдите на
      закладку Styles

      Кликните на
      заготовке
      стиля

Создание стиля.

Так как все стили в ТМ основаны на заготовках , то Вы можете создавать свои
стили.  Для этого необходимо применить любой существующий стиль, а затем на
закладке Attributes (Атрибуты) изменить его параметры.
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Библиотека стилей (Style Library).

Библиотека стилей предназначена для хранения и упорядочивания стилей
текста. ТМ поставляется с более чем 150 шаблонами стилей от Inscriber, но Вы так же
можете добавлять и упорядочивать, созданные Вами стили.

Зачем используют Библиотеку стилей?

Библиотека стилей делает доступными Ваши стили для применения в любых
титрах и предоставляет быстрый и легкий путь для организации и поиска необходимого
стиля в ТМ. Библиотека стилей так же позволяет Вам обмен стилями текста между
титрами, без использования одинаковых шаблонов.

Открытие и закрытие Библиотеки стилей.

Вы можете открыть Библиотеку стилей, выбрав пункт Open Style Library из меню
по правому клику.

Шесть кнопок диалогового окна предоставляют все инструменты, необходимые
для управления Вашими стилями.

                                                                                               Инструменты для
                                                                                               управления Вашими
                                                                                               стилями

Закрыть окно Библиотеки стилей, вы можете двумя способами:

• Выбрать Сlose.
• Нажать на кнопку Esc.

Загрузка стиля.

Для того чтобы загрузить стиль в выбранное окно заготовки, необходимо:

1. Выбрать окно заготовки стиля.
2. Открыть Библиотеку стилей.
3. Выбрать стиль, который хотите загрузить.
4. Нажать на кнопку Load Style (Загрузить стиль), или двойной клик на стиле.

Библиотека стилей загрузит стиль в окно заготовки и закроется.
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Выберите                       Откройте Библиотеку        Выберите          Нажмите на
заготовку стиля            стилей                                   стиль                 кнопку Load Style

Изменение стиля.

Вы можете заменить стиль в Библиотеке стилей на созданный Вами текстовый
стиль титров. Для этого необходимо:

1. Создайте титр в CG, используя один из стилей.
2. Откройте Библиотеку стилей.
3. Выберите стиль, который Вы  хотите заменить на ранее Вами созданный.
4. Нажмите на кнопку Update.
5. Нажмите на Yes, для подтверждения замены выбранного стиля на Ваш.

   Создайте стиль в CG      Откройте Библиотеку стилей       Выберите стиль

                                                                                               Нажмите на кнопку
                             Нажмите на кнопку Yes для                          Update
                             подтверждения замены стиля



27

Добавление стиля.

Вы можете добавить текущий текстовый стиль в Библиотеку стилей.

1. Примените стиль в CG.
2. Выберите Add to Style Library  из меню по правому клику на окне заготовки стиля.

Когда Вы добавляете стиль в Библиотеку, необходимо сделать правый клик на том
окне заготовки, из стиля которого Вы сделали текущий титр. СG создаст новое окно
заготовки в библиотеке, использующее  установки заготовки стиля, в окне которого Вы
сделали правый клик, а не установки выбранной строки текста.

                                                                                             Создайте стиль
                                                                                             в CG

                                                                                             Выберите Add To
                                                                                             Style Library

3. Введите порядковый номер стиля.

Стили сортированы по номерам. Все стили от Inscriber имеют номера выше 1000, и
сортированы по типам. Вы можете так же сортировать по группам номеров Ваши
собственные стили.

4. Введите название для стиля.
5. Нажмите ОК.

                                          Введите номер          Введите название
                                          для стиля                   для стиля

                                                                                                                  Нажмите на
                                                                                                                  кнопку ОК
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Переименование стиля.

Вы можете переименовать стиль или дать ему новый номер.

1. Откройте Библиотеку стилей.
2. Выберите стиль, который Вы хотите переименовать.
3. Нажмите на кнопку Rename (Переименовать).
4. Введите новое название или порядковый номер стиля.
5. Нажмите ОК.

                                             Введите новое имя                                 Нажмите
                                             или номер                                                 кнопку ОК

              Откройте Библиотеку
              стилей

                  Выберите стиль

              Нажмите на кнопку
              Rename

Удаление стиля.

Вы можете удалить стиль из Библиотеки стилей.

1. Откройте Библиотеку стилей.
2. Выберите стиль для удаления.
3. Нажмите на кнопку Delete (Удалить).
4. Нажмите Yes для удаления стиля.

                                                                      Выберите стиль       Нажмите кнопку
                                                                                                           Delete

                 Откройте Библиотеку
                 стилей

                 Нажмите на
                 кнопку Yes для
                 удаления стиля
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Введение и передвижение текста.

Ввод текста.

Для ввода текста Вам необходимо быть в плоскости текста и строка для ввода
должна быть выбрана. Когда Вы первый раз открываете ТМ для создания титра,
плоскость текста обычно выбрана по умолчанию, и курсор мигает внутри белого
прямоугольника. Однако это бывает не всегда. Так процедура, описанная ниже,
объясняет все необходимые шаги для ввода текста.

1. Нажмите на кнопку выбора плоскости текста на панели инструментов ТМ.
2. Установите курсор внутри белого прямоугольника и кликните в нем.
3. Введите строку текста.

                                                                                          Нажмите на кнопку выбора
                                                                                          плоскости текста

       Нажмите внутри белого
       прямоугольника

      Напишите строку текста

Якорный и плавающий текст.

Якорный текст - это текст, неподвижный горизонтально. Это означает, что Вы
можете двигать такой текст вверх или вниз, но не можете двигать его в сторону.

Плавающий текст Вы можете двигать в любом направлении.

Якорный текст заключается в квадратные скобки, а плавающий текст заключен в
белый прямоугольник. Так что, кликнув на линии текста, Вы можете легко определить
какой у Вас текст, якорный или плавающий.

Вы можете легко переключаться между ними.
1. Кликните на строке текста.
2. Нажмите Crtl+Tab для переключения между якорным и плавающим текстом.

         Нажмите на тексте

                                                                                    Нажмите комбинацию клавиш
                                                                                    CTRL+TAB для переключения
                                                                                    между якорным и плавающим
                                                                                    текстом
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Передвижение плавающего текста

1. Кликните на строке текста.
2. Расположите курсор выше или ниже середины строки текста так, чтобы справа

от курсора появился маленький "+".
3. Передвиньте строку в любую новую позицию.

                                                                       Нажмите на
--------------------------------------------                  строке текста
Вы можете нажать клавишу
CTRL, и удерживая ее,
переместить курсор выше или
ниже строки для перенесения
ее в новую позицию
---------------------------------------------

                                                              Разместите указатель            Перетащите строку
                                                              выше или ниже                        в новую позицию
                                                              середины строки

Передвижение якорного текста

1. Нажмите на строке текста.
2. Расположите указатель мыши выше или ниже середины линии текста, так, чтобы

справа от стрелки появился маленький значок "+".
3. Передвиньте строку в любую новую позицию.

Даже если Вы передвинете курсор из одной стороны в другую, все равно не
сможете передвинуть его в сторону, только вверх или вниз.

                                                                      Нажмите на
                                                                     строке текста

                                                    Разместите указатель            Перетащите строку
                                                    выше или ниже                        в новую позицию
                                                    середины строки
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Модифицирование текста.

Изменение параметров переноса текста.

Вы можете установить автоматический перенос текста при достижении границы
зоны 100% видимости титров на видео. Для этого выберите Element ->Constrain->Word
Wrap (Элемент->Выравнивание->Перенос слова). Тогда, если Вы, удалив или изменив
текст, сможете заново перенести обновленный текст путем исключения промежутков
или пауз нечетных строк.

1. Выделите текст, которому хотите заново задать перенос.  Для этого кликните в
первой строке текста и перетащите указатель над выделяемым текстом.

2. Выберите Element -> Re-Wrap Selection (Обновить перенос в выделенной
области) или Re-Wrap selection из меню по правому клику в CG.

Только в  выделенном тексте будет обновлен перенос.

                                                                                      

                                                                                     Выделите текст

                                                                                     Выберите Element ->Re-Wrap
                                                                                     Selection

Именение размеров и поворот текста.

Вы можете изменять размеры и угол поворота текста, используя мышь. Курсор
изменяет свой внешний вид в зависимости от того, где он располагается над строкой
текста. Следующий рисунок показывает различные виды курсора и где они
появляются.
          Помните, если Вы сделаете текст
очень маленьким, Вы не сможете
его выделить и изменить стиль
текста. Вероятно, Вы должны
сначала выбрать стиль текста,
а потом изменять его размеры.

              Форма указателя                                      Расшифровка
Move Tool • Передвижение текста в новую позицию

Resize Text Height and Width • Изменение ширины и высоты текста

Resize Text Width • Изменение ширины текста

Rotate Text • Поворот текста
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Проверка правописания (Spellcheck Titles)

Функция проверки правописания позволяет Вам проверять правильность
написания титров во всем тексте или тексте на определенном слое. Вы можете
определить виды ошибок правописания, которые будет просматривать Spellcheck . А
так же можете установить настраиваемые словари пользователя.
1. Наберите текст.
2. Выберите Element-Spellcheck-Title Page (Элемент-Проверка правописания-Страница

титров).
Если при проверке орфографии будет найдена ошибка, то она отобразиться в
диалоговом окне Подсказки.

3. Исправьте слово, выполнив одно из следующий действий:
• Нажмите на конопку Replace (Заменить) и выберите слово в поле Подсказки.
• Выберите другое слово из списка Подсказки и нажмите Replace.
• Наберите правильно слово в поле Подсказки и нажмите Replace.
• Нажмите на Ignore (Игнорировать), оставив слово неисправным.

4. Нажмите на Quit Checking для завершения проверки правописания.

Введите     Выберите Element->
текст          Spellcheck ->
                   Title Page               Нажмите на  Replace       Нажмите на Quit Checking
                                                   для исправления
                                                   слова

Создание и модифицирование Dictionaries (Словарей).

С диалоговым окном Подсказки на экране, Вы можете  также создавать и
модифицировать свои собственные словари, так же как и модифицировать опции
проверки орфографии.
1. Нажмите на Add для добавления неизвестного слова в Ваш обычный словарь.

Откроется  диалоговое окно обычного словаря. С его помощью, вы можете
добавить новое слово, удалить слово и ввести новое название Вашего обычного
словаря.
2. Кликните на Add to Default для добавления слова в словарь по умолчанию.
3. Кликните на Options (Опции), чтобы увидеть опции настройки проверки

правописания, используемых для поиска неправильно написанных слов.

Включенные опции будут использоваться для проверки правописания, а не
включенные будут игнорироваться.
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Продвинутые функции текста.

Вертикальный текст (Vertical Text).

Эта функция располагает текст вертикально один символ над другим, начиная с
верхнего правого угла Вашего текста, двигая левую сторону титров.

Вертикальный текст имеет несколько ограничений:
• Вы можете использовать вертикальный текст в неподвижных титрах (Still) и титрах-

барабане (Roll).
• В неподвижных титрах текст автоматически переносится с верхней строки на

следующую, но в титрах-барабане Вы должны нажать Enter для перехода с верхней
строки на следующую.

• Вертикальный текст доступен только с 1-го по 8-й слой, а на 9-м и 10-м  - нет.

1. Убедитесь что Вы находитесь в плоскости текста в СG.
2. Выберите Element -> Layer Control -> Vertical Text Processing (Элемент –>

Управление слоями –> Обработка Вертикального текста).
3. Начните печатать текст.

                                                                                                        Убедитесь, что Вы
                                                                                                        находитесь на
 ----------------------------------------                                                       плоскости текста
Вы можете переключаться
между нормальным и
вертикальным текстом,
нажимая ALT+V
----------------------------------------

                                                                        Выберите Element ->           Введите текст
                                                                        Layer Control ->
                                                                        Vertical Text Processing

Текст в Коробке.

Вы можете создать ограниченную по ширине область (Коробку), для написания
титров. Когда Вы меняете размеры Коробки, текст будет автоматически переноситься,
подгоняясь под ее новый размер.

1.  Кликните на инструменте Text Box (Коробка).
2. Нарисуйте границы Коробки для Ваших титров (нажмите левую клавишу мыши и

растяните границы до нужных размеров ).
3. Введите текст в ограниченную область Коробки
4. Используя захваты на границах Коробки, измените ее размер.

Когда Вы измените ее размер, текст автоматически будет переноситься. Вы можете
регулировать только ширину Коробки, высота будет изменяться автоматически, в
зависимости от объема текста в Коробке.
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                                                                                                                       Нажмите на
                                                                                                                       инструмент
                                                                                                                       Text Box

      Нарисуйте        Введите текст         Используя захваты,
      Коробку            внутри Коробки      измените размеры Коробки

Текст, написанный в Коробке, располагается в плоскости графики. Убедиться в этом
можно, выделив текст в Коробке, а затем нажав на Коробку.

Тест по окружности.

Вы можете создать титры, расположенные по окружности. Когда Вы изменяете
ее размеры, текст будет автоматически перерисован вокруг новой окружности.

Текст по окружности, располагается в плоскости графики. Убедиться в этом
можно, выбрав текст, а затем нажать на окружность.
1. Выберите инструмент Text Path (Траектория текста).
2. Нарисуйте прямоугольник над Вашим титром, нажав левой клавишей мыши и

удерживая ее, растянув границы.
Траектория текста появится внутри прямоугольника.

3. Выберите Element -> Constrain -> Circle (Элемент –> Выравнивание ->Окружность)
4. Введите текст вокруг окружности.
5. Используя захваты на границах прямоугольника, измените размеры окружности.

Текст автоматически расположится вокруг новой окружности.

                                           Нажмите на инструмент
                                           Text Path                        

                                                                                                         Нарисуйте
                                                                                                         прямоугольник
                                                                                                         для Ваших титров

                                Выберите Element -> Constrain -> Circle

                                                           Введите текст вокруг окружности

                                                          Используя рычаги, измените размеры
                                                          окружности
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Текст по кривой.

Вы можете создать криволинейную траекторию для размещения Вашего текста.
Когда Вы измените ее форму, текст автоматически перерисуется вдоль новой
траектории.

1. Выберите инструмент Text Path.
2. Нарисуйте прямоугольник на Ваших титрах.

Кривая появится внутри прямоугольника, если прямоугольник будет достаточно
большим.

3. Введите текст на кривой.
4. Используя точки управления, измените форму траектории.

Текст автоматически перепишется по новой траектории.

                                                                          Нажмите на инструмент
                                                                          Text Path

    Нарисуйте прямоугольник       Введите текст          Используя точки
                                                           на кривой                 управления, измените
                                                                                              форму кривой

Текст на криволинейной траектории находится так же в плоскости графики.
Вы можете добавлять контрольные точки на траектории, нажав на Ctrl+SPACEBAR.

Для удаления контрольных точек с траектории, нажмите Ctrl+BACKSPACE. Новая точка
всегда появляется сверху оригинальной точки. Чтобы увидеть ее, Вам необходимо
нажать и перетащить новую точку в другую позицию.

Вы также можете вернуться к начальной траектории по умолчанию, выбрав
Element -> Constrain -> Default Path (Элемент – Выравнивание – Траектория по
умолчанию).
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                Кривая по умолчанию                  Передвижение точек управления

                                  Новая точка управления               Удаление контрольной точки

Удаление Коробок, Кривых и Окружностей.

Текст в Коробке, на Кривой или на Окружности, использует стандартные
инструменты редактирования, такие как: кнопки стрелок, BACKSPACE, комбинации
клавиш Ctrl+X, Ctrl+C, Ctrl+V. Однако, Вы можете использовать комбинацию Ctrl+X для
удаления графического объекта, но эта комбинация не будет работать для удаления
Коробок, Кривых и Окружностей.

Если Вы хотите удалить целые Коробку, Кривую или Окружность, используйте
комбинацию Ctrl+Delete. Когда Вы удалите выбранный  целый объект, тогда и текст,
содержащийся в нем, будет удален. Если Вы просто хотите редактировать текст в
Коробке, на Кривой или Окружности, Вы можете кликнуть на нем и использовать
стандартные инструменты редактирования текста.

Когда Вы удалите целую Коробку, Кривую или Окружность, графический объект
удалиться, и Вы останетесь на плоскости графики. Однако, после удаления ничего не
будет выбрано. Так что Вам будет необходимо кликнуть на графическом объекте или
переключиться в плоскость текста для работы с Вашим титром.

                                              Стандартный инструмент
                                          редактирования для
                                          изменения отдельных
                                          букв

                                           CTRL+DELETE
                                           удаляет целый объект
                                           и его текст
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Форматирование текста.

Вы можете видоизменять внешний вид текста в титрах, используя закладки
Атрибутов для изменения различных параметров.

Некоторые руководства по форматированию текста.

Вы можете видоизменять текст, используя закладки Size & Attributes (Размер и
Атрибуты) и Color & Texture  (Цвет и Текстура). Чтобы лучше увидеть действия всех
параметров, введите некоторый текст и изменяйте по одной каждую настройку.
Следите за изменениями, к которым они приводят.

Однако, руководства, описанные ниже, призваны сделать процесс
форматирования текста легче.
• Если Вы делаете изменения на закладках Size & Attributes и Color & Texture, то весь

текст, состоящий из нескольких стилей, будет изменен. Если вы хотите изменить
только часть текста, выделите ее, а затем вносите изменения на закладках.

• Если Вы хотите редактировать текст, то параметр Rotation (Вращение)
(регулируется на закладке Size & Attributes) должен быть равным 0. Вы должны
сначала внести все  изменения, а затем развернуть текст.

Изменение Face (Лицевая сторона символов).

1. В CG выберите шаблон по умолчанию из открывающегося списка шаблонов.
2. Введите строку текста в CG.
3. Выделите слово в строке текста.

                           Выберите шаблон
                           по умолчанию
                           (Default Template)

                           Введите текст

                           Выделите слово

4. Измените, параметры в закладке Size & Attributes, как показано в следующем
      примере.

        Измените параметры                                            Перейдите на закладку
        на закладке                                                             Color & Texture
        Size & Attributes

5. Перейдите на закладку Color & Texture.
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6. Нажимайте на окне Face (окно образца цвета для лицевой стороны символов) до
тех пор, пока в нем не появится слово TOP (Верх).

7. Введите следующие параметры цвета: H=0, L=30, S=100.

                              Нажимайте на окне          Измените значения параметров
                              примера цвета Face         цвета H, L, S

Изменение параметров Edge (Окантовка, бордюр).

Эта процедура предполагает, что Вы продолжаете после шага 7.
1. Нажмите на окне заготовки цвета Edge.
2. Нажимайте на окне примера цвета до тех пор, пока не появится слово TOP.
3. Введите параметры цвета H=0, L=96, S=100.
4. Измените параметр Edgiting (Размер окантовки) на значение 2.
5. Выберите тип окантовки Outline (Окантовка с внешней стороны).
6. Введите значение параметра Angle (угол наклона градиента цвета окантовки)

равное 29.

                Нажмите на окне                   Нажмите на окне              Измените значения
                заготовки цвета                    примера цвета Edge        параметров цвета
                Edge                                                                                     H, L, S

 Измените размеры
 Edge

                Выберите Outline                             Измените угол наклона градиента цвета

Изменение параметров Shаdow (Тень).

Изменение параметров Shadow производится таким же способом, как и
изменение параметров Edge.
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Расширенные стили текста.

ТМ так же содержит и расширенные стили.  В Библиотеке стилей находится
много их примеров, но в этой главе будет рассказано, как Вам самим создать
собственные расширенные стили текста.

Типы расширенных стилей.

Расширенные стили текста состоят из этих 6 типов стилей:

                                                           (Углубленный)              (С окантовкой над лицевой
                                (Украшенный)                                             стороной)

                                (10 Окантовок)                                             (Неон)
                                                                   (С отблеском)

               Создание расширенного стиля текста.

1. В СG выберите шаблон по умолчанию из открывающегося списка Templates.
2. Введите короткое слово, например, Next или Live.

                          Выберите шаблон
                          по умолчанию

                                Введите текст

3. Введите в закладке Size & Attributes значения параметров, как показано в
следующем примере.

4. Выберите тип окантовки Sheen.
5. Перейдите на закладку Color & Texture.
                                                                        Перейдите на закладку
Измените значения на                                Color & Texture
закладке Size &                                                                                 Выберите тип
Attributes                                                                                            окантовки Sheen
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6. Введите значения H=204, L=31, S=92 для всех  четырех окошек выбора цвета
лицевой стороны символа. Для этого необходимо кликнуть на каждое из окошек и
ввести эти значения.

7. Измените цвет Sheen на значения H=60, L=89, S=26, путем нажатия на окно выбора
цвета Sheen и введения этих значений HLS.

8. Введите параметры Size =31, Offset=-7, Angel=-26.
9. Нажмите на зацикленную кнопку опций Edge & Sheen.

                                                                                                          Изменение цвета,
                                                                                                          методом введения
                                                                                                          числовых значений

                                                                                                        Измените цвет
                                                                                                        Sheen

   Зацикленная кнопка        Измените цвета         Измените значения
настроек Edge и Sheen       Face                             Size, Offset и Angle

Выбор более чем одного цвета Face, с использованием кнопок выбора
Нажмите на “Х” для выбора всех четырех примеров цвета Face

Нажмите на “– “ для выбора двух окошен выбора цвета Face с обоих ее сторон .

10.   Измените параметры Edge, Size и Angel как показано на следующем примере.
11.   Измените цвет нижней левой окантовки на H=0, L=0, S=0.
12.   Измените цвета трех других окантовок на значения H=223, L=33, S=84.

                                                                                                                    Измените цвета
                                                                                                                    трех других
                                                                                                                    окантовок

                   Измените значения            Измените цвет нижней
                   параметров                         левой окантовки
                   Size Edge, Size и
                   Angle
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Как использовать стили.

Все тексты ассоциируются со стилями группы. Вы можете изменить эти стили
строки текста, путем нажатия на разные окна заготовок стилей на закладке Styles.
Главное, что Вам нужно помнить о стилях есть то, что весь текст отформатированный
несколькими стилями будет изменяться, когда Вы регулируете параметры в закладках
Size & Attributes и Color & Texture. Однако, если перед этим выделить часть текста, то
изменится только она. В этой главе объясняется, как производить форматирование
текста. Более подробно с этим можно познакомиться в онлайновой справке.

Изменение параметров многострочного текста.

Стиль групп позволяет форматировать параметры многострочного текста на
всех строках.

1. В CG выберите шаблон по умолчанию из открывающегося списка Templates.
2. Перейдите на закладку Style.
3. Кликните на окне стиля №15.
4. Введите три или четыре строки текста титров.
5. Перейдите на закладку Color & Texture.

                      Выберите шаблон
                      по умолчанию

                      Введите некоторый
                      текст

                      Перейдите на
                      закладку Color &
                      Texture

                                                                                            Перейдите на       Нажмите на
                                                                                            закладку Style      Стиль № 15

6. Нажмите на окне выбора цвета Shadow.
7. Измените значение цвета Shadow на значения H=0, L=31, S=100.

Весь текст Вашего титра изменится, когда Вы отрегулируете параметры на
закладках Size & Attributes или Color & Texture.
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                                                                                                               Измените цвет                
                                                                                                               Shadow

        Нажмите на окно выбора цвета Shadow

Изменение параметров одной строки или символа.

Один раз, выбрав основной стиль, Вы можете использовать выделения
для изменения параметров части текста. Вы можете выделить одну или
несколько строк или символов.

1. В CG выберите шаблон по умолчанию из открывающегося списка Templates.
2. Напишите названия трех городов.
3. Выделите часть текста, нажав левой клавишей и перетягивая курсор мышки.

                                                                Посмотрите на форматируемый пример

              Выберите шаблон
              по умолчанию

              Введите названия
              нескольких
              городов

              Выделите
              некоторый текст

             Перейдите на
             закладку Color &
             Texture

             Нажмите на окно
             заготовки цвета
             Face
                                                                                                             Измените цвет Face
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4. Перейдите на закладку Color & Texture
5. Нажмите на окне выбора цвета Face.
6. Измените значения цвета на H=157, L=69, S=99.
7. Посмотрите на окно примера форматируемого шаблона стиля в палитре на

Toolbar.

Знак “+” означает, что если Вы сделаете изменения в стиле, то они не будут
действовать на выделенный текст.

8. Нажмите на другую строку  текста для отмены выделения.
9. Нажимайте на окно выбора цвета Face, пока на нем не появится слово

BOTTOM (Низ).
10.  Измените параметры цвета BOTTOM на H=238, L=80, S=84.

Заготовка стиля и текст, которые не были выделены, изменятся, а выделенный
текст останется с теми же параметрами.

11.  Перейдите на закладку Style.

                                                                                                                    Измените цвет
                                                                                                                    Bottom (для Face)

        Нажмите на       Нажимайте                        Перейдите на
        другую               на пример                         закладку Style
        строку                цвета  Face, пока
        текста                 не появится слово
                                    Bottom

12. Выделите заглавную букву названия первого города.
13.  Нажмите на стиль №15.
14.  Выделите заглавную букву в названии второго города и нажмите на стиль

№15.
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15. То же самое сделайте с заглавной буквой названия третьего города.
16.  Расположите курсор на начале названия одного из городов.

В правом нижнем углу, в окне форматируемого стиля, увидите цифру 15.

17.  Перейдите на закладку Color & Texture.

                                                                        Выделите заглавную
Выделите заглавную                 букву второго слова                    Нажмите
букву первого слова                  и нажмите на                                  на Стиль
                                                       Стиль № 15                                     № 15

          Выделите заглавную
          букву третьего слова
          и нажмите на
          Стиль № 15

           Расположите Ваш
           курсор в начале
           названия города

                                                                                                    Перейдите на закладку
                                                                                                    Color & Texture

18. Нажмите на окне выбора цвета Face.
19. Измените параметры цвета Face на H=162, L=84, S=40.

Весь текст отформатированный стилем №15 изменится с изменением цвета
Face, но остальной текст, включая текст, выделенный Вами, останется без
изменений.

                                                                                                                 Измените цвет Face

               Нажмите на окне заготовки
               цвета Face
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Элементы титров.

Вы можете изменять другие элементы титров, которые находятся вокруг
текста. СG имеет возможность легко создавать и видоизменять элементы
титров.

Backgrounds (Задник, Фон).

Закладка Background содержит все необходимые настройки для создания
фонов с использованием видео, цветного фона, прозрачности, узоров или
графических изображений и текстур.

Вы можете создать видеофон, нажав на кнопки Video, или сделать его
черным, нажав на кнопку Black.

Последовательность действий, описанных ниже, объясняют как создать
фон в виде сложного узора, используя наклонный цветной градиент (плавный
переход между цветами). Для более детальной информации о создании фонов,
обратитесь в онлайновую справку.

1. В CG выберите шаблон по умолчанию из открывающегося списка Templates.
2. Перейдите на закладку Background.
3. Нажимайте на окно образца цвета, пока не появится слово TOP.
4. Измените параметры цвета TOP на H=0, L=52, S=99.

                Выберите шаблон
                по умолчанию

                Перейдите на
                закладку
                Background

              Нажмите на
              окно примера
              цвета

             Измените цвет
             Background

5. Нажимайте на окно образца цвета, пока не появится слово BOTTOM.
6. Измените параметры цвета BOTTOM на H=225, L=52, S=99.
7. Выберите узор Blocks (Блоки) из списка Pattern (Заготовки узоров)

Названия узоров Вы можете увидеть на всплывающей подсказке, когда Вы
наводите курсор на них.

8. Измените размер Pattern на 4.
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        Нажмите на окно
        образца цвета

Выберите узор
Blocks                                                                                                                      Измените
                                                                                                                                  цвет
Измените размер                                                                                                Background
узора Blocks

9. Установите угол наклона градиента равным 30.
10.  Установите значение прозрачности ТОР равным 75%.
11. Установите значение прозрачности ВОТТОМ равным 25%.

Сейчас цветной фон полупрозрачный. Сквозь него частично можно видеть
видео, на которое положен этот фон. Но элементы узора при этом остались
непрозрачными для видео.

                                                                                                           Измените
                                                                                                           прозрачность ТОР

                                                                                                           Измените
                                                                                                           прозрачность ВОТТОМ

                                                                                                      Измените угол наклона
                                                                                                      градиента (Angel)

Screen Markers (Маркеры экрана).

Закладка View (Просмотр) позволяет отображать на экране полезные
элементы для выравнивания и расположения текста и графических объектов,
такие как: границы действия функции Tab (Табуляция), Video Safe Title Area
(границы зоны видимости титров на видео), Baseline (Базовые линии).

Вы можете показать каждый элемент, поставив галочку напротив него. Вы
также можете видоизменить зону Video Safe Title Area и границы действия
функции Tab, нажав на соответствующую кнопку Еdit (Настройки изменения
параметров).

Layers (Слои).

Каждый титр в CG имеет 10 слоев, и каждый слой делится на плоскости
текста и графики (см. ранее).



47

Неподвижные титры (Still), Барабан (Roll), Бегущая строка (Crawl), и
Анимации (Animations).

Вы можете создать 4 типа титров в CG: Still, Roll, Crawl и Animation. Первые три
вида создаются полностью в СG, а Аnimation-создается в CG и анимируется в FX.

Выбор типа титров.

1. Нажмите на открывающийся список типов титров.
2. Нажмите на нужном типе титров.

                                  Нажмите на открывающийся                     Выберите тип титра
                                  список типов титров

О Неподвижных титрах (Still).

Still – это неподвижное изображение на экране, содержащее текст и графические
объекты, которые располагаются над фоном.

О Барабане (Roll).

Roll – это тип движущихся вверх или вниз текста и графических объектов над
статичным фоном. Этот тип титров используется в ситуациях, когда необходимо
прокрутить текст вертикально. При создании Roll используется белая пунктирная
линия, предназначенная для разметки границ страниц. Эти линии не видны при
проигрывании Roll-титров. Они служат для визуального разбиения файла титров на
страницы, чтобы с ними было легче работать. Полоса прокрутки титров (Scroll Bar)
также появляется для того, чтобы можно было прокручивать текст вертикально.

Если Вы в Roll-титрах расположите графический объект (лого или др.), то они
будут прокручиваться вместе с текстом. Однако Вы можете создать отдельный фон
для Roll-титров, который останется неподвижным, а текст будет двигаться над ним
вертикально.

Вы не можете регулировать скорость движения Roll-титров в ТМ. Любые
изменения скорости движения необходимо делать в программе нелинейного монтажа.

О Бегущей строке (Crawl).

Crawl – это тип титров в виде бегущей строки горизонтального текста,
двигающегося справа налево. Crawl не ограничен одной строкой текста. Текст может
располагаться в любом месте титров и содержать любое количество строк (объем
текста).

При проигрывании Crawl-титров не будут видны пунктирные линии,
показывающие границы страниц, так же как и при Roll-титрах. Текст будет
продолжаться при проигрывании, а внизу окна CG Editor появится Scroll bar, которая
позволяет прокручивать текст горизонтально.
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Если Вы расположите в Crawl-титрах графические объекты, то они будут
прокручиваться вместе с текстом. Вы так же можете создать фон для Crawl-титров,
который будет неподвижен, в то время как, Crawl-титр будет прокручиваться над ним.

Вы не можете регулировать скорость движения Crawl-титров в ТМ. Любые
изменения скорости движения необходимо делать в программе нелинейного монтажа.

Об Анимациях (Animations).

Анимации позволяют изменять путь следования текста и графических объектов,
появляющихся во времени. Вы начинаете с неподвижного текста и графики, и когда
используете FX для анимации движения, то сами принимаете решение, как будет
изменяться каждый объект во времени. Вы можете изменять движение, цвет, ритм или
прозрачность двигающегося текста или графики в виртуальном 3D пространстве.

Фоны титров не будут видны в Анимациях, пока не поставите галочку Export
Background на закладке Animation Setting (Установки Анимации) в CG.

Все анимации основываются на CG-титрах. Если Вы создали титр и когда
нажимаете на кнопку FX, ТМ спросит, хотите ли Вы преобразовать титры в Анимацию?
Если Вы нажмете Yes, ТМ преобразует титры в Анимации, используя установки
Анимации по умолчанию и откроет FX.

Если Вы выберите Animation из открывающегося списка типа титров, то сможете
использовать установки Анимации (Animation Setting) для выбора как экспортировать
текст и фон титров.

Export Layer as Single Object делает каждый слой отдельным объектом в FX

Export Text as Characters                         Export Text as Lines
делает каждую букву                                делает каждую строку
отдельным объектом в FX                      отдельным объектом в FX

Если Вы используете текст в Коробке, на Кривой или по Окружности, помните,
что CG обрабатывает эти виды текстовых объектов, как графические и может
импортировать их только как одиночные объекты. Пункт Export Text As Characters
(Экспорт текста как отдельных символов) не действует на эти три типа тиров.
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Цвет (Color).

В ТМ выбор цвета осуществляется, используя одну из трех цветовых моделей
представления цвета (HSV, HLS, RGB) или используя Color Picker (Цветовая пипетка).
Она позволяет выбрать цвет из любого приложения, которое Вы можете открыть в
Windows.

Использование Color Models (Цветовых моделей).

Вы можете выбирать цвета, используя одну из трех цветовых моделей. В
примере, описанном ниже, используется HLS модель, но методы для выбора цветов
одинаковы во всех трех цветовых моделях.
1. В CG нарисуйте прямоугольник, используя инструмент Rectangle (Прямоугольник).
2. Перейдите на закладку Сolor & Texture.
3. Выберите HLS из открывающегося списка выбора Color Models (Модели цвета)
4. Нажмите на Color Selector (Селектор цвета) и перетащите его в новое

местоположение в поле выбора цвета.

Когда Вы перетаскиваете Selector Selector то меняются значение параметров L
(Luminance (Яркость)) и S (Saturation (Насыщенность)), а так же цвет в окне Color
Picker.

5. Нажмите на Color Slider (Ползунок выбора цвета) и перетащите его вверх или вниз
по полосе выбора цвета.

Когда Вы перетаскиваете Color Slider, то изменяется значение параметра Н (Hue
(Оттенок)), а также будет изменяться цвет в окне Color Picker.

                Нарисуйте                                                        Перейдите на закладку
                прямоугольник                                               Color & Texture

                                                                                                                         Выберите HLS

                                                                                                                            Нажмите и
                                                                                                                            перетащите
                                                                                                                            Color Slider

                                                     Нажмите и перетащите Color Selector

6. Нажмите на кнопку L.
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Сейчас полоса Color Slider показывает доступные пределы изменения Luminance, а
окно Color selection (Окно выбора цвета) – доступные пределы изменения Hue и
Saturation.

7. Нажмите на кнопку S.

Положение указателей на полосе Color Slider и в окне Color selection снова изменились.

                                             Нажмите на                                                 Нажмите на
                                             кнопку L                                                       кнопку S

Color Picker (Цветовая пипетка)

Цветовая пипетка позволяет выбрать любой цвет, видимый на экране.
1. Измените размеры окна ТМ таким образом, чтобы было видно окно  Рабочего

стола Windows.
2. Нажмите на Color Picker и перетащите ее через видимую часть экрана Рабочего

стола Windows.

Цвет пикселя под кончиком цветовой пипетки будет отображаться в окне цвета
Color Picker. Его цвет будет изменяться с перемещение Color Picker по экрану.
3. Нажмите на левую кнопку мышки для выбора цвета под пипеткой,

показываемого в окне цвета Color Picker.

                                                                                                                                       Уменьшите
                                                                                                                          окно ТМ

                                                                                                                     Нажмите кнопку
                                                                                                                     мышки для
                   Нажмите и перетащите Color Picker                                  выбора   цвета
                   через экран                                                                            под указателем
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Color Gradients (Цветные градиенты).

Вы можете создать двухцветный градиент с многократным повторением, как для
текста, так и для графических объектов.

Создание градиента.

Эта процедура объясняет, как создать градиенты для текста. Для создания
градиента для графического объекта процедура такая же.

1. В CG, выберите шаблон по умолчанию из открывающегося списка Templates.
2. Введите строку текста.
3. Перейдите на закладку Color & Texture.
4. Нажимайте на окно выбора цвета Face до тех пор, пока не появится слово TOP.
5. Измените значения параметров цвета ТОР на H=0, L=31, S=100.

                                              Выберите шаблон по умолчанию

                                  Введите текст                                            Измените цвет ТОР

          Перейдите на
          закладку
          Color & Texture

    Нажмите на образец
    цвета Face

6. Нажимайте на окно выбора цвета Face, пока не появится слово ВОТТОМ.
7. Измените значения параметров цвета ВОТТОМ на H=0, L=100, S=0.

Нажмайте на окно
выбора цвета Face
до появления слова
ВОТТОМ

Измените цвет
ВОТТОМ
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8. В секции Gradient на закладке Color & Texture установите значение параметра Angel
     (Угол наклона перехода) равным 45°

Если секция Gradient не видна на закладке, нажимайте на зацикленную кнопку с
черным треугольником, до ее появления.

10. Выберите Line из открывающегося списка Character/ Line.
11. Установите значение Linear (Количество линейных переходов между цветами на

протяжении строки текста) равным 3.

Измените значения
ТОР и ВОТТОМ

Выберите Line

                                                          Сделайте параметр Linear                  Сделайте
                                                           равным 3                                                параметр
                                                                                                                            Angel = 45°

Вы можете создать радиальные (круговые) градиенты на символах, путем
установки пункта Char из открывающегося списка Character/ Line и последующего
нажатия на кнопку Linear для переключения в состояния Radial.
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Оbjects (Объекты).

Вы можете создать много различных графических объектов, используя
графические инструменты в CG. Вы так же можете добавлять Logos (Логотипы,
графика) с Альфой в титры CG, и текстуры к Вашим титрам и графическим объектам.

Графические объекты.

Палитра Tools предоставляет все инструменты форматирования, необходимые
для создания любого вида графических объектов в CG. Процедура, описанная ниже,
объясняет как, используя одну общую графическую форму, создать любую
графическую форму в несколько шагов.
1. В CG, выберите шаблон по умолчанию из открывающегося списка Templates.
2. Нажмите на инструмент Horizontal Panel (Горизонтальная панель).
3. Нарисуйте прямоугольник.
4. Перейдите на закладку Size & Attributes.
5. Измените значение параметра Edge Size (Размер окантовки) на 17.
6. Измените тип Edge Type (Тип окантовки) на Tube (Труба).

Выберите шаблон                       Нарисуйте                            Нажмите на инструмент
по умолчанию                              прямоугольник                   Horizontal Panel на
                                                                                                       палитре
                                                                                                      форматирования

                                                                                                         Измените параметр
                                                                                                         Edging

                                                                                                          Измените тип Edge
              Перейдите на
              закладку
              Color & Texture

7.  Перейдите на закладку Color & Texture.
8.  Нажмите  на окно выбора цвета Face.
9.  Нажмите на кнопку Video.
10.  Перетащите панель вниз титров.
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                                                                                             Перетащите панель
                                                                                             вниз титров

                                                                                                  Перейдите на закладку
                                                                                                  Color & Texture

                                                                                                         Нажмите на кнопку
Нажмите                                                                                         Video
на окно заготовки
цвета Face

Logos (Логотипы).

Вы можете добавить логотипы в Logo Map (Карта Логотипов) и использовать их
как графические объекты. В онлайновой справке имеется более детальное описание
использования и создания логотипов.

Процедура, описанная ниже, объясняет, как добавлять логотип в Logo Map.
1. Перейдите на закладку Logos.
2. Сделайте правый клик на свободном слоте.
3. С помощью Навигатора Windows найдите логотип, который Вы хотите использовать

и выберите его.

Вы можете посмотреть его в окне Preview, нажав на это окно. Некоторые примеры
логотипов доступны в папке Samples расположенной в директории ТМ.

4. Нажмите ОК.                             Правый клик на             Перейдите на закладку
                                                        пустом слоте                  Logos

   Найдите нужный логотип
   с помощью Навигатора
   Windows

   Нажмите на кнопку Open
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5. Нажмите на инструмент Logo.
6. Нарисуйте Коробку в поле титров.
7. Нажмите на импортируемый логотип в закладке Logos.

Оно появится на Вашем слое c размерами, заданными нарисованной Коробкой, но
нажимая на шкалы масштабирования на закладке Logo, лого и Коробка будут
изменяться и станут равными пропорциям оригинального файла.

                                                                                                     Нажмите на инструмент
                                                                                                     Logo

                                                                                                      Нарисуйте Коробку

                                                                                                      Нажмите на логотип на
                                                                                                      На закладке Logos

Использование Карт Текстур.

Вы можете нанести на текст или графику, в дополнении с использованием
цветов Solid, еще и карту текстур.

1. В CG выберите шаблон по умолчанию из открывающегося списка.
2. Нажмите на инструмент Rectangle (Прямоугольник).
3. Нарисуйте зону "Коробки" на поле титров.

          Выберите шаблон                              Нажмите на инструмент Rectangle
          по умолчанию

                                                                                                                 Нарисуйте Коробку

4. Перейдите на закладку Color & Texture/
5. Нажмите на окно примера Текстуры.



56

          Перейдите на            Нажмите на окно
          закладку                     примера
          Color & Texture          Текстуры

6. Нажмите на первый пустой слот диалогового окна Tеxture Map.
7. Нажмите на кнопку Define (Определить).
8. Используя стандартную навигацию, найдите и выберите искомый графический
    файл.
8. Нажмите на кнопку Open (или двойной щелчок на выбранном файле)

Нажмите на первый
пустой слот

Нажмите на кнопку
Define                                                                                                                       Нажмите
                                                                       С помощью Навигатора                на кнопку
                                                                       найдите файл с Текстурой           Open

10.  Нажмите на ОК в окне Texture Map.
11.  Уберите флажок с пункта Tint (оттенок) для просмотра выбранной текстуры без
       цветного оттенка.

--------------------------
Функции Tile и Size
определяют
масштаб налогаемой
Текстуры. Функции
Align определяют
как Текстура                                                                                                Нажмите ОК
выравнивается на
объекте.
--------------------------                                                                                                      Уберите
                                                                                                                                      галочку
                                                                                                                           напротив Tint
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Анимации и Ключевые кадры.

 Эта глава объясняет основы Анимаций в FX, включая шаблоны и другие
применения. В онлайновой справке предлагается полное объяснение всех FX-закладок
и функций.

     Keyframes (Ключевые кадры) определяют каждые основные моменты на каждой
траектории Анимации, такие как, начальная и конечная точки, изменение направления
движения, начало и конец действия эффекта. Траектории в Анимациях называются
Splines (Сплайны). Анимация в FX есть результатом создания некоторого количества
ключевых кадров и регулировки их Сплайнов.
     Вы можете добавлять Ключевые кадры и стоить анимации вручную, или Вы можете
использовать шаблоны. Обычно, их использовать очень легко, если Вам не нужно
стоить очень точных Анимаций. Для более детального рассмотрения См. главу
"Модификация Анимационных шаблонов".
     Когда Вы переносите титр из CG в FX, Вы можете выбрать, как экспортировать
каждый объект титра. Текст может быть экспортирован как отдельная строка или по
отдельным знакам (буквам), или Вы можете экспортировать каждый слой как
одиночный объект. Эти установки Вы найдете на закладке Animation Setting в CG и их
нужно установить перед тем, как переносить титр в FX.

Выберите  на закладке Animation Setting пункт Export Background для
сохранения фона титра с Анимацией.

Маркеры на Сплайнах.

     Сплайны позволяют передвигать центр Вашего объекта. Они состоят из линий,
кадров (frames) и Ключевых кадров (Keyframes). Каждый маленький квадрат на
Сплайне представляет кадр, если Вы не будете добавлять их слишком много, то
сплайн из них будет выглядеть раздельно. Каждая большая пронумерованная коробка
(Box) называется Keyframes (Ключевым кадром)

            Невыбранный               Сплайн               Ключевые                 Каждая коробка
            ключевой                       соединяет             кадры                      на траектории
            кадр показывается      ключевые      идентифицируются     представляет
            в виде тусклого            кадры и          номером в центре        кадр
            прямоугольника           показывает    коробки
                                                     траекторию
                                                     Анимации
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Шаблоны FX

      Использование шаблонов  в FX позволяет быстро и легко добавлять анимацию в
титры. Однако Вы должны понимать, как работает закладка Templates, для того чтобы
воспользоваться преимуществами всех доступных особенностей. Вы можете выбрать
шаблон и посмотреть его Preview в закладке  Templates перед использованием.

     Вы можете выбрать шаблон       Для переключения между закладками
     из списка шаблонов                      Applied и Template не обходимо нажать на

                   ее название

                                                                                                    Нажмите на кнопку Play
                                                                                                    для просмотра шаблона
                                                                                                    выбранной закладке

        Используйте закладку Template          Используйте закладку Applied
        для просмотра шаблона в                    для просмотра шаблона с
        оригинальном виде                               использованием в виде объекта
                                                                           Ваших титров

Кнопки, расположенные ниже списка шаблонов, позволяют создавать и
управлять шаблонами Анимации. FX поставляется с установленными Стандартными
шаблонами, но Вы можете создать Ваши собственные шаблоны или загрузить
некоторые с сайта www.Inscriber.com

                                                                                                                              Экспорт
                                                                                                                              шаблона
  Добавить                                                                                                               для
  новый                                                                                                          использования
 шаблон                                                                                                               другими
                                                                                                                      пользователями
                  Обновление                                                           Импорт
                  шаблона                                                                  шаблона от других
                                                                                                    пользователей или с веб-
                                  Переименование          Удаление        сайта Inscriber
                                       шаблона                    шаблона

Вам необходимо нажать на кнопку Apply (Применить), после того, как выберите шаблон
и установите опции для него или сделаете изменения в закладке шаблонов не
используемых первоначально.
Если Вы не нажмете кнопку Apply, то изменения, внесенные на закладке Templates,
не применятся к Вашей Анимации.

http://www.Inscriber.com
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Анимация титров.

1.  В CG выберите шаблон 0 Default Template, из открывающегося списка.
2.  Напишите слово “TitleMotion”.
3.  Перейдите в FX.

 Ответьте Yes, когда ТМ спросит, хотите ли Вы конвертировать текущий титр в
Анимацию

Перейдите в FX                                                              Выберите шаблон по
                                                                                           умолчанию

Введите
некоторый текст

4. Выберите первый ключевой кадр

   Вы можете выбирать ключевые кадры нажав на них, или выбирая объекты из
ниспадающего списка Оbjects (Объектов) и вводя порядковый номер Ключевого кадра
в поле кeyframes.

                                                                               Палитра инструментов FX позволяет
                                                                               модифицировать и позиционировать
                                                                               Ключевые кадры

               Выберите первый
               Ключевой кадр

           Закладки Атрибутов в FX
           позволяют вводить
           цифровые значения
           параметров

                  Выберите Ключевые
       кадры из открывающегося
           списка Объектов (Object)
                           и в поле номера
                         Ключевого кадра

5. Нажмите на кнопку INSERT на Вашей клавиатуре для добавления второго
     кейфрейма.
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6.  Перетащите второй кейфрейм в новую позицию.
7.  Нажмите на кнопку PLAY для предпросмотра Вашей Анимации.
8.  Выберите второй кейфрейм.

Нажмите клавишу Insert
для добавления Ключевого
кадра

Перетащите второй
Ключевой кадр в новую
позицию

Выберите второй
Ключевой кадр

Нажмите на зеленую
кнопку Play

 9.  Нажмите снова клавишу INSERT для добавления третьего кейфрейма.
10. Перетащите третий кейфрейм в новую позицию.
11. Нажмите на PLAY для предпросмотра Вашей Анимации.
12. Выберите второй кейфрем.
13. Нажмите на клавишу DELETE на Вашей клавиатуре для удаления второго
      кейфрейма.
14. Нажмите на PLAY для предпросмотра Вашей Анимации.

                                                            Нажмите на клавишу Insert         Предпросмотр
                                                            для добавления третьего           финальной
                                                            Ключевого кадра                          Анимации

  Нажмите клавишу Delete для
  удаления второго
  Ключового кадра

  Выберите второй  Ключевой
  кадр

  Нажмите на кнопку Play для
  предпросмотра Анимации

  Перетащите третий Ключевой
  Кадр в новую позицию
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Использование шаблонов Анимации.

Шаблоны - это самый легкий путь для анимации титров.
1. В CG выберите Шаблон Template 1118 Lower Third 18 из открывающегося списка
      Шаблонов.
2. Перейдите в FX.

Нажмите на YES когда ТМ спросит Вас, хотите ли Вы конвертировать текущий титр
в Анимацию.

        Перейдите в FX                     Выберите шаблон № 1118

3. Перейдите на закладку Templates.
4. Выберите Heading из открывающегося списка Объектов (Object).
5. Выберите Шаблон 1 from left/to left из списка Теmplates FX.
6. Поставьте флажок напротив пункта Reverse и выберите пункт Beginning.
7. Нажмите на Apply.

Выберите Heading из                                               Перейдите на               Нажмите на
открывающегося списка Объектов                       закладку Templates    кнопку Apply

                    Выберите шаблон №1 из               Поставьте флажок напротив Revers
                    cписка шаблонов FX                       и выберите Beginning

8.    Выберите второй кейфрейм Heading (Заголовок)
9.    Выберите Шаблон 3 bottom/to bottom из списка Теmplates FX.
10.   Нажмите  на кнопку Append (Придаток, Приложение).
11.   Уберите флажок в пункте Reverse.
12.   Нажмите на кнопку Play на закладке Templates для предпросмотра Анимации.
13.   Нажмите на кнопку Absolute (Абсолютный)

Если Вы используете шаблон Absolutely (Абсолютно), то FX игнорирует позицию
Ваших текущих кейфреймов и двигает их к оригинальной позиции шаблона.
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Если Вы используете шаблон Relatively (Относительно), то FX поддерживает
(сохраняет) позиции выбранного кейфрейма и использует шаблон относительно его
начальной позиции.

Выберите второй Ключевой кадр           Нажмите на кнопку Play
Heading                                                                                                        Нажмите

                                                                                             Absolute

               Выберите шаблон №3 из списка           Нажмите Append                  Снимите
               шаблонов FX                                                                                флажок Reverse

14. Нажмите на кнопку Play на закладке Templates для предпросмотра Абсолютного
позиционирования.

15.  Нажмите на кнопку Relativе.
16.  Нажмите на кнопку Apply.
17.  Нажмите не кнопку Play в правом нижнем углу FX Editor (Монтажное поле FX) для

предпросмотра получившейся Анимации.

Нажмите кнопку
Play в FX Editor

     Нажмите Play

           Нажмите
           Relative

Нажмите Apply
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Модифицирование Animation Templates (Шаблонов Анимации).

Вы можете создать, изменить или экспортировать Ваши собственные шаблоны,
использовать шаблоны от Inscriber или импортировать и экспортировать шаблоны,
делясь с другими пользователями ТМ.

Создание шаблона.

Вы можете создать Ваш собственный шаблон.
1. В CG выберите шаблон 1118 Lower Third 18 из открывающегося списка

шаблонов.
2. Перейдите в FX.

Нажмите Yes, когда ТМ спросит, хотите ли Вы конвертировать текущий титр в
Анимацию.

Перейдите                                                                      Выберите шаблон № 1118
в FX

3. Перейдите на закладку Templates.
4. Выберите Heading (Заголовок) из открывающегося списка объектов.
5. Выберите шаблон 1 From left/ To left из списка шаблонов FX.
6. Поставьте флажок в поле, напротив Reverse, и конечно же выберите Beginning

(Начало).
7. Нажмите Apply.
                                                                                                                    Нажмите Apply

   Выберите Нeading                        Перейдите на закладку
                                                            Templates

                                      Выберите                                               Поставьте галку
                                      шаблон №1 из списка                          Reverse и выберите
                                      шаблонов FX                                          Beginning

8. Двигайте новый кейфрейм Heading в новую позицию.
9. Перейдите на закладку Filter (Фильтр).
10.  Измените значение параметра Blur (Смаз, размытие) на значение 13∗0
11.  Перейдите на закладку Templates.
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Передвиньте
новый Ключевой
кадр в другую
позицию

Перейдите на
закладку
Templates

Измените значение
Blur на 13x0

Перейдите на
закладку
Filter

12.   Нажмите на кнопку Add (Добавить).
13.   Нажмите Yes.
14.   Введите номер и название для вашего шаблона.
15.   Нажмите ОК.

                         Введите номер и название                                   Нажмите ОК
                         шаблона

                    Нажмите Yes

      Нажмите Add

Замена существующего шаблона.

Вы можете изменять шаблоны, создавая оригинальные или модифицируя
существующие. Это можно сделать, выбрав название шаблона из списка, а затем
нажав кнопку Update.
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Настройки шаблонов.

Вы можете выбрать различные настройки для Ваших шаблонов, которые
определяют, как каждый шаблон используется в Вашей существующей Анимации. Вы
можете также обмениваться Вашими шаблонами с другими пользователями ТМ или
загружать шаблоны с веб-сайта Inscriber (www.inscriber.com), используя команды Import
и Export.

Переписывание - Добавление (Overwrite vs Append)

Вы можете переписать существующие кейфреймы или добавить новые к
существующим, когда применяете шаблоны.

Если Вы выберите Overwrite (Переписать), то все существующие кейфреймы
будут удалены, и вместо них будет использоваться начальное значение выбранного
объекта.

Относительный - Абсолютный (Relative vs Absolute).

Вы можете применять шаблоны относительно или абсолютно.
Если применяется шаблон относительно, тогда FX сохраняет позиции

выбранного кейфрейма и использует шаблон относительно его начального положения.
Если используется шаблон абсолютно, тогда FX игнорирует положение текущих

кейфреймов и двигает их к оригинальной позиции шаблона.

Начало - Конец (Beginning vs End)

Вы можете применить шаблон к началу или к концу сплайна. Если выберите
Beginning (Начало), шаблон будет применен перед первым кейфреймом, не обращая
внимания на то, какой кейфрейм выбран.

Если Вы выберите End (Конец), шаблон будет применен после последнего
кейфрейма, не принимая во внимание на выбранный кейфрем.

Кнопка-флажок Реверс (The Reverse Checkbox).

Флажок в поле Reverse применяет действие шаблона в обратном направлении, и
работает в соединении с настройками Beginning и End.

Увидеть, как действует эффект флажка Reverse, можно с помощью окна
Предпросмотра (Preview) на закладке Templates, используя различные комбинации
настроек Beginning и End, и наличия или отсутствия флажка в поле Reverse.

Экспорт шаблона.

1. В FX выберите шаблон Анимаций на закладке Templates.
2. Нажмите на кнопку Export.
3. Используя стандартную навигацию, выберите папку, в которую Вы хотите

сохранить шаблон.
4. Введите название шаблона.
5. Нажмите Save (Сохранить).

FX добавит расширение .ifx к Вашему названию файла. Все шаблоны FX имеют
расширение .ifx.

http://www.inscriber.com
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          Выберите папку
          для экспорта

         Введите название
         шаблона

       Выберите шаблон         Нажмите на кнопку Экспорт      Нажмите на кнопку Save

Импорт шаблона.

1. Нажмите на кнопку Import.
2. Используя навигацию, выберите шаблон для импорта.
3. Нажмите Open.
4. Введите порядковый номер и название для импортируемого шаблона.
5. Нажмите ОК.

                                                                                                                        Нажмите Open
                                                     Выберите Ваш шаблон

   Введите название и
   номер для Вашего
   шаблона

     Нажмите кнопку Import                                                    Нажмите кнопку ОК
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Настройка Сплайнов и Кейфреймов.

Вы можете, на свой вкус,  настраивать позиции сплайнов, изменяя установки
кейфреймов на закладке Attributes. FX создаст сплайны автоматически, основываясь
на установки кейфреймов.

Использование закладки Spline.

Вы можете использовать закладку Spline для изменения формы Вашего сплайна. Для
более подробной информации по этой закладке, обратитесь к онлайновой справке.

1. В CG выберите шаблон 1118 Lower Third 18 из списка шаблонов.
2. Перейдите в FX.
Нажмите Yes, когда ТМ спросит, желаете ли Вы конвертировать текущий титр в

Анимацию.
                    Перейдите в FX

                                                 Выберите шаблон №1118

3. Нажмите кнопку Insert на Вашей клавиатуре.
4. Передвиньте новый появившийся  кейфрейм в правый верхний угол поля титров.

Нажмите на               Передвиньте кейфрейм в                                           Нажмите на
кнопку                        правый верхний угол                                                  Reverse Path
Insert

Нажмите
Play

Перейдите
на
закладку
Spline

Двигайте ползунок Ease OUT                    Измените параметр          Tension на 5
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5. Нажмите на инструмент Reverse Path (Реверс траектории).
6. Перейдите на закладку Spline.
7. Измените значение параметра Tension (Натяжение) на 5.00.

Вы можете поменять направление сплайна на обратное, используя инструмент
Reverse Path (Обратная траектория)

Параметры Tension, Сontinuity (Непрерывность) и Bias (Уклон) изменяют форму
вашего сплайна и распределяют кадры вдоль него. Вы можете видеть, какой
эффект вносит каждый из этих параметров на выбранный сплайн, изменяя
положение соответствующих ползунков.

Если Вы имеете больше двух кейфреймов на сплайне, эффекты от действия
этих параметров более очевидны.

8. Нажмите кнопку Play и посмотрите, как эти изменения подействовали на Вашу
Анимацию.

9. Подвигайте ползунком Ease OUT of Keyframe в стороны.

Когда Вы перетаскиваете ползунок, то квадратики, представляющие кадры,
двигаются вдоль Вашего сплайна. Вы можете использовать ползунки Ease IN и  Ease
OUT для управления кадрами и пространством вдоль сплайна.

Копирование и вставка кейфреймов.

Вы можете копировать и вставлять кейфреймы для передачи атрибутов из
одного объекта в другой. Когда Вы копируете и вставляете кейфреймы, Вы не
копируете объекты, а применяете FX атрибуты к этим кейфреймам.

Копируя кейфрейм и вставляя его атрибуты, следуйте этому главному правилу:
- Выберите кейфрейм.
- Выберите Edit -> Copy (Ctrl+C).
- Выберите другой объект из открывающегося списка Object.
- Выберите Edit -> Paste (Ctrl+V).

 Когда Вы вставляете
скопированные атрибуты, FX
добавляет новый кейфрейм,
который будет иметь все эти
атрибуты, включая позицию
скопированного кейфрейма. Вы
можете решить, где будет
вставлен новый кейфрейм,
выбрав из меню Edit -> Paste
Attributes вместо Edit -> Paste.
Когда Вы выбираете Edit ->
Paste Attributes, FX не
добавляет других кейфреймов
в конец сплайна. Вместо этого,
он изменяет параметры
выбранного кейфрейма.
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Временные настройки Анимации.

Вы можете управлять временными параметрами каждого объекта траектории
движения, включая позиционирование каждого кейфрейма, а так же позиционирование
кейфреймов и сплайнов относительно друг друга.
1. В CG выберите шаблон 1803 Info Screen 4 из открывающегося списка шаблонов.
2. Перейдите в FX.

Нажмите Yes, когда ТМ спросит, хотите ли Вы конвертировать текущий титр в
Анимацию.
                      Перейдите в FX
                                                                           Выберите шаблон 1803

3. Выберите кейфрейм Heading.
4. Нажмите дважды на кнопку Insert на Вашей клавиатуре.
5. Передвиньте новый кейфрейм в новую позицию.
6. Нажмите на инструмент Reverse Path.
7. Перейдите на закладку Templates.
8. Выберите кейфрейм Point 1.
9. выберите шаблон 1 fromleft/to left.

                          Передвиньте кейфреймы               Выберите          Нажмите на
                                                                                       Heading              Reverse Path

Нажмите клавишу
 Insert дважды

                  Выберите
                  кейфрейм
                  Point 1

              Перейдите на
              закладку
              Templates

              Выберите
              шаблон №1

     Выберите Beginning и Reverse                     Сделайтеt Count =4,                Нажмите
                                                                                 а Stegger=31                             Apply
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10.   Выберите Beginning и Reverse на закладке Templates.
11.   Сделайте параметры, Count (Счет) равным 4, а Stagger (Шатание) равным 31.

Параметр Count, равный 4, автоматически применяет шаблон к выбранному
объекту и следующим трем объектам в списке Object. Вы можете изменить порядок
расположения объектов в списке в CG, используя настройки Bring To Front
(переместить вперед) и Send To Back (переместить назад).

Значение параметра Stagger, представлено четырьмя отдельными временными
шкалами, равными по длительности. Первая из них, начинается с 0-го кадра, вторая –
на 31м кадре, третья – на 62 кадре, и четвертая - на 93 кадре.

12.   Нажмите Apply.
13.   Перейдите на закладку Time (Время) и переместите, ползунок прокрутки вниз, пока
       не увидите шкалы времени Point 1, 2, 3, 4.
14.   Нажмите Play.

      Перейдите на закладку Time,                                                             Нажмите Play
      и опустите вниз ползунок
      прокрутки до появления
      временных шкал Point

15.   Переместите ползунок прокрутки вверх, до временной шкалы Heading.
16.   Нажмите на ромбик в середине слайдера Heading и передвигайте его по сторонам.
17.   Перетащите конец слайдера Heading вправо.

Вы можете укоротить или удлинить траекторию любого объекта с помощью этого
ползунка на закладке Time.

18.   Нажмите Play.

                             Передвиньте ромбик                    Прокрутите шкалу
                             назад и вперед                               времени Heаding

                             Передвиньте конец шкалы                             Нажмите Play
                             времени Heading
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Альфа и Выделения.

Вы можете использовать Logo Compose для очищения лого и добавления им
альфа – канала.

Выделение области на изображении.
В этой главе объясняется, как использовать инструмент Lasso (Лассо), но любой

другой инструмент выделения, работает таким же образом.
1. В Logo Compose выберите File -> Import/Export -> Import Image и импортируйте

Samples\Vendor Sample Images\Aztec\1553_043.tif с Вашего СД с ТМ     :))
2. Выберите инструмент Lasso на палитре инструментов.
3. Перейдите на закладку Select (Выбор).
4. Используйте инструмент Lasso для выделения только листа в центре изображения.

Кнопки на закладке Select определяют, как каждое выделение обрабатывается.
• Single Selection (Одиночное Выделение) – создает новое выделение, каждый раз,

когда Вы рисуете новую внешнюю линию.
• Add To Selection (Добавление Выделения) – добавляет новое выделение к

текущему
• Subtract From Selection (Вычитание из Выделения) – вычитает новое Выделение из

текущего
• Intersect Selection (Пересечение Выделений) – пересекает любое новое Выделение

с текущим таким образом, что только общая площадь для обоих Выделений будет
выделена

• Move Selection (Перенос Выделения) – двигает выделение, куда бы Вы его не
перетащили

5. Использование инструмента Zoom (Масштаб), увеличивает изображение для
удобства работы с его деталями.
Кликните на области изображения, которую Вы хотите рассмотреть более детально.

Чтобы вернуть масштаб в начальное значение, нажмите на Alt и одновременно
кликните снова на этой области.

                 Импортируйте
                   изображение

   Используйте инструмент
         Zoom для увеличения
                         изображения

        Выберите инмтрумент
                                       Lasso
                        Перейдите на
                                 закладку
                               Templates

            Используйте кнопки
                        селекции для
                 выделения листа
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Добавление альфа-канала.

Вы можете добавить к изображению альфа-канал, используя в Logo Compose
инструмент Alpha (Альфа). В Logo Compose Вы можете рисовать с альфой, заполнять
альфой и создавать альфа-градиенты.
В этой главе объясняется, как добавить к изображению альфу, предполагая, что Вы
уже имеете конечный результат предыдущей процедуры.

1. Нажмите на кнопку Invert (Инвертировать) в закладке Select.
2. Выберите инструмент Add Alpha из палитры инструментов.
3. Перейдите на закладке Brush (Кисть).

Выберите инструмент
Add Alpha

Перейдите на закладку
Brush

Нажмите на кнопку
Invert

4. Нажмите на самую большую кисть с мягкими границами.
5. Нажмите и переместите курсор в любое место на изображении, для начала

добавления альфы.

Так как Вы используете выделение, Logo Compose только добавляет альфу к
области без выделения. Так что лист окажется нетронутым, даже если Вы перетащите
кисть над ним.

Вы так же можете быстро заполнить целое выделение альфой, выбрав инструмент
Alpha Fill (Заливка Альфой) из
палитры инструментов, и нажав
в любом месте, внутри
выделения.

Нажмите и перетащите
для добавления Aльфы

Нажмите на самую большую
кисть с мягкими границами
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Очищение изображения.

Вы можете удалить нежелательные части изображения, используя фильтры для
модификации изображения.

Удаление нежелательных деталей.

Самым легким путем удаления таких деталей, есть замена их другими
областями изображения с помощью инструмента Clone (Клон).

1. В Logo Compose откройте Samples\Vendor Sample Images\Aztec\1553_043.tif с
Вашего СД с ТМ.

2. Выберите из палитры инструментов Zoom .
3. Нажмите на пятно на листе два или три раза, увеличивая его.
4. Выберите Clone на палитре инструментов.
5. Перейдите на закладку Brush.
6. Выберите вторую кисть с мягкими границами.
7. Нажмите на Alt и кликните на области возле пятна, которую можете использовать

для замены пикселей пятна.

Подберите наиболее подходящий цвет. Для этого, вспомните природу листа.

8. Нажмите и перетащите выбранную часть листа, двигая указатель над пятном, для
его замещения.

Вы можете видеть, как пятно будет выглядеть, размещая указатель над ним. Logo
Compose показывает превью результата взмаха кисти под указателем. Так что, Вы
можете убедиться в правильности смешивающего клонирования перед тем, как
применить его. Вы можете изменить выбранную область листа в любое время,
нажав на клавиатуре Alt и кликнув в новом месте.

   Импортируйте
     изображение

Выберите
      Нажмайте на Инструмент
      лист для его Zoom
 увеличенияния

Выберите
          Нажмите и инструмент
        перетащите Clone
 для замещения
                   пятна

          Нажмите и
        перетащите
       область для
         замещения
                   пятна Выберите

вторую кисть
     Перейдите на с
             закладку полумягкими
           Templates границами
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Использование Filters (Фильтры).

Вы можете использовать фильтры для регулировки и очистки Ваших
изображений.

1. В Logo Compose откройте Images\Aztec\1553_043.tif с Вашего СД с ТМ.
2. Перейдите на закладку Filters (Фильтры).
3. Выберите Inscriber Filters (Фильтры от Инскрайбер).
4. Выберите фильтр Color Adjustment (Настройка цвета).
5. Выберите фильтр Brightness & Contrast (Яркость и Контраст).
6. Нажмите кнопку Select (Выбор).
7. Измените значение параметра Brightness на 18, а Contrast на 33.
8. Нажмите ОК.

Импортируйте
изображение

                                                                                                                         Измените
                                                                                                                              параметры
Перейдите на                                                                                                      Brightness
закладку                                                                                                               и Contrast
Templates

Выберите
фильтры от
Inscriber                                                                                                               Нажмите ОК

     Нажмите
     Select

                   Выберите фильтры                           Выберите фильтры
                   Color Adjustment                                 Brightness и Contrast

В онлайновой справке, объясняется каждый фильтр, доступный в logo Compose, и
рассматривается, что регулирует каждая их настройка.

Когда Вы закончите модифицировать Ваше изображение, Вы можете добавить его в
Sb таким образом, чтобы была возможность использовать его в CG.
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ТМ и NLE (системы нелинейного монтажа).

Работа с NLEs.

ТМ работает как плагин для Вашей NLE, и поскольку, с каждой NLE, она
работает немного по разному, Inscriber создал серию релизов примечаний,
описывающих работу ТМ с каждой NLE индивидуально. Эти примечания доступны на
веб-сайте www/insriber.com.

Когда вы сохраните файл в ТМ, он перебрасывается в папку (Bin) или в другое
удобное место хранения, где Ваша NLE ожидает найти файлы CG и Анимации.

Если ТМ работает не как плагин к Вашей NLE, или работает в режиме Stand-
alone (самостоятельно), Вы можете экспортировать титры и Анимации как
последовательность файлов Тарга ( расширение *.tga), которые Ваша NLE может
импортировать и объединить.

Вы так же можете экспортировать изображения или последовательности
изображений, используя команду File -> Export. В онлайновой справке более детально
объясняется как использовать функцию экспорта.


